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More E-mail and Calendar Options

Objectives
Learn how to use advanced functions in Outlook e-mail, calendar, and
use public folders.

« E-mail options
Setting delegates and permissions
View another person’s e-mail
Set the security level of an e-maill
Setup Rules for processing e-maill
Using Flags
Recall a sent message
Voting Options
Creating Rules
Send replies to another email address
o Send email on behalf of someone else
% Address Book
o Share distributions lists
« Calendar
o Create an appointment and invite others
Tracking
Sharing
View multiple calendars
Create a desktop shortcut
Printing the calendar (formats)
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E-Mail Options

Delegates

You can give another person access to your Inbox (and any other
Outlook folder) by granting the person delegate access. There are several
levels of access you may use that determines if your delegate will have
read, create, modify, and delete permission to your folder.

Options

You can set
delegates for any

Delegates
@ Delegates can send iterms on your behalf. To grant pel

OUthOk f0|der yOU < others to access your folders without also giving them

. send-on-behalf-of privileges, go to the Properties dialog box for each
own. Access this folder and change the options on the Permissions tab.
screen by clicking ' add..

on Tools>>Options
and clicking on the
Delegates tab.

K l l Cancel

Exercise 1: Set a Delegate on the Inbox
1. Click Tools>>Options.
2. Click the Delegates tab in the Options dialogue box.
3. Click Add to select a person as a delegate.
4. Select a name from the Add Users dialogue box and click Add (or
double click on a name).
5. Click OK.
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Delegate Permissions: P J. Snodgrass

You can set delegate

This delegate has the fallowing permissions

permissions on any Outlook e o (con reos, recte, and oy o) [RG
folder from this screen. Be sure [7oelegasfgeceiies copies of et rlated messages sent s e
to carefully read what each W X
permission level allows. I ’
Editor level allows read, create, A s pone =
and modify, Author can read jé = ;
and create items’ ReViewer [ autamatically send a message to delegate summarizing these permissions
can only read items in the area [Joeisgats can see my privae fame

you specify.

Exercise 2 : Complete the Permission

1. Click the selection arrow for the Inbox.

2. Select the permission level you need.

3. Click OK.

(You will see the person’s name listed in the Delegate box.

4. Click Apply then OK to complete the action.
(To remove the action, click the person’s name then the Remove
button.)

If you are a delegate to another person’s Inbox, you may add their
mailbox to your account for quick and easy access. You must have
at least reviewer permission to open their mailbox.

Exercise 3: Add another Inbox to your View.
1. Click Tools>>E-mail Accounts
Click View or change existing e-mail accounts then Next
Select the account type
Click Change
Click More Settings then click the Advanced tab
Click Add and type the mailbox name of the person you
want to add to your profile.
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Set Importance/Sensitiviy Level for an E-mail

This option lets your e-mail recipients see the level of importance and/or
sensitivity you set on your message
from their own inbox.
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Exercise 4: Set Importance and Sensitivity
1. Start a message to someone in the class.
2. Click either the Importance High or Importance Low button on the
toolbar
3. Send the message
4. Check your Inbox for the e-malil

Exercise 5: Create a Rule for Your Inbox
1. In the Navigation Pane, click Mail.
2. On the Tools menu, click Rules and Alerts.
3. If you have more than one e-mail account, in the Apply changes to
this folder list, click the Inbox you want.
4. Click New Rule.

Do one of the following:
Use a template with pre-specified actions and | @startceaigarie from s tempiate
condition and select the template you want. st fom s barkre

Step 1: Select a template

Create the rule by specifying your own Stay Organiced
CO n d Itlo ns aCtI O ns: an d exce ptIO nS (th |S O ptl O n ma h ec ds in the subject to a folder
is not available when you create a Rule for a 5 oy e 0 dutrbution 0 folder
p u bll C fold er) . St:; JLaE;n;is::es From someone with a colored Flag
= Display mail from someane in the Mew Them Alert Window
. :El Play a sound when [ get messages from someane
1 . Cll C k Start fro m a b | an k ru |e1 an d th e n @ Send an alert ko my mobile device when I get messages From someone
Cl | Ck N eXt. Skep 2: Edit the rule description (click an underlined value)

Apply this rule after the message arrives

2. Under Select when messages should be from people or distrbution st
move it to the specified folder
checked,
3. Select Check messages when they
arrive or Check messages after sending,
and then

4. Click Next.

Example: Move mail from my manager to my High Importance folder

Follow the rest of the instructions in the Rules Wizard.

If you want to run this rule on messages already in one of your folders,
select the Run this rule now on messages already in " folder" check box on
the last page of the Rules Wizard.

To have this rule apply to all your e-mail accounts and Inboxes, select the
Create this rule on all accounts check box on the last page of the Rules
Wizard.

If you want to run a rule periodically but not all the time, do the following:
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On the Rules and Alerts dialog box, turn the rule off by clearing the

1.
check box next to the rule.

2. Click Run Rules Now.

3. In the Run Rules Now dialog box, under Select rules to run, select the
check box next to the rule you want to run.

4. Select the folder that you want to apply the rule to.

5. Select the category of messages that you want to apply the rule to.
For example, you can apply the rule only to unread messages in a
folder.

6. Click Run Now.

Exercise 6: Use Flags to
Cateqgorize Emails

Flagging a message is easy,
and you have six colors to
choose from. You can
designate one color to
indicate important messages
in your Inbox. You can even
set a reminder with the flag —
to remind you to reply to or
act on the message.

Arranged By: Flag

=) unflagged

=i at-tennessee

4 Lois Idal
Important

=1 Jennifer H, Whitaker
RE: Thanksgiving

[@TEMMESSEE] Mews far Faculty and Skaff - Mow 30, 2005

5 Level 2 doc
ed on top ~
P J. Snodgrass [snodgrasdbutk.edu)
lidal@utk.edu
B:dd AM otk Level 2.dac (197 KE)
here it is...
2:39 AM

P. J. Snodgrass, Ph.D

IT Specialist II

Office of Information Technology (OLT)
Training Technology Team

8133 AM
t

Right Click on it.
Select Follow Up.
Select Flag desired.
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Exercise 7: Recall a Sent Message

€ Open
i Dessa Beswic 7:59 AM 2427 Dunford Hall
i S| Brint i [865) 974-7315
Presidential J
. & Repl
— - [e-thEer P. J. Snodgrass, Ph.D
part-Time Jof| 1| Reply to &l * IT Specialist IT
= < Forward [z Office of Information Technology (OIT)
Part-Time Joy — ® Training Technology Tescm
S View Attachments » -— 2427 Dunford Hall
Re: [VOLNGT| Follow Lip » | ¥ RedFlag Fl 974-7315
o pmtr = Mark as Unread ¥ Blue Flag
Re: [YOLINGT]
2 Categories... ¥ | elow Flag
RE: Outlook 1] Find All » | ¥ GreenFlag
= Strickdondto| (25| Create Rule... ¥ Orange Flag
. LrounaT] Junk E-mail » | ¥ Purple Flag
—i Amy Elias
Fie: Lab Clasq 24 Delete « Flag Complets
=i Lab Services | L% | Move to Folder... Add Reminder...
) Re: Lab Clas 2 Cptiors. . Clear Flag
2 Koy
Re: [YOUNST] (none} SetDefault Flag b
. T

Select the message you would like to flag.

Need to recall a message? You can do that for email accounts that are
on the Microsoft Exchange Server only. You can only recall messages that

have not been opened.

1.

Actions>>Recall This Message.

Open the message in your Sent Items folder and then choose
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Exercise 8: Voting Options

. = —
In Order to VOtel users mUSt be US|ng ?JE\Ie Edit “iew [nsert Format Tools Table Ywindow Help aaf
Outlook 2003. £t a0 e 17 )
HIRY f | | juc | A e 2|
ii=dsend | accounts~ | 0 - |G & |8 T OB ¥ S ”ﬂo;;tmns.” ‘v|F'Iam Text -
1. Create a new message . i
. . To... Eric Cardwel
2. On the Menu bar, Click Options. dee..
3. Under Voting and Tracking B Vescage Options ®
Options E Message sethings Se% I;
y Importance: | Marmal - Changs security settings For this messags.
4. Check the box marked Use Voting il T
E F| voting angd Tracking options
ButtonS. \\i> (AE [usevyingbuttons: | Approve;Reject v
s [ |Rearest a delivery receipt For this message
[IRequest a read receipt for this message
M | Gty ptiers
There are several default [P
responses. If these do not meet 3| Dsswsmimesosto [sentitons
N [[]Do not deliver before:
your needs, you can create your Dlespies atr
own by deleting the existing Q;Z‘d“i:‘;””””“ e A .
responses & typing in new ones. Be
sure to separate each response b
) SEP P y
a semicolon.

Once you have entered the criteria, you can also request a
delivery receipt of this message and/or a read receipt of this
message. If you would like either of these, check the

appropriate box.

5. Click Close to save the changes.

Exercise 9: Respond to a Vote Request

1. Open the e-mail message & click on the button with your

response & send the response.

To Track the responses

1. Open the original message you are tracking
2. This message is usually located in the Sent Items folder.

3. Click the Tracking tab.

By default, responses that do not contain comments are recorded
in the original message, and responses that contain comments are
kept in the Inbox. You can have Microsoft Outlook automatically

delete the blank responses.
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You will also receive an e-mail each time a user responds.

If you need to, you can copy & paste the responses into Excel.

Exercise 10: Have replies to an email sent to another person

1.
2.
3.

4.

Exercise 11

Create a message.

Click Options.

Under Delivery options, select the Have replies sent to check
box.

Type the name of another person, or click Select Names to
select from a list (you cannot have replies sent to a
distribution list)

: Send an email on behalf of someone else.

. On the File menu, point to New, and then click Mail Message.

Note: Even though you can click From and select any name
from the Global Address Book, you are allowed to send a
message only on behalf of someone who has granted you
that permission.

In the From box, type the name of the person you are
sending on behalf of. If you leave the box blank, the message
is sent from you.

If you do not see the From box above the To and Cc
boxes, do the following: In the message window, on the
E-mail toolbar, click the arrow on the Options button,
and then click From. If you are not using Microsoft
Office Word 2003 as your default editor, in the message
window, on the View menu, click From Field.
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Calendaring

This section will cover how to invite others to a meeting and track their
responses, view group schedules, open another person’s calendar, and
print a calendar

Exercise 12: Create an Appointment With Invitees
1. Start a New Appointment
Enter the details for the appointment
Click Invite Others
Click the Add option.
Select at least 2 others in the class to invite to the meeting.
Click Send.

oahkwnN

(Open your Inbox and Accept the meeting request.)

Exercise 13: Check the Tracking of the Meeting.
1. Go to Calendar View
2. Open the Appointment
3. Click the Tracking Tab

Exercise 14: Open a Shared Calendar
1. Click Open a Shared Calendar
2. Enter the Name of the person who has shared their calendar

Exercise 15: Create a Desktop Shortcut
You can create a shortcut to a calendar in a Public Folder, if you have
rights to that calendar.

Navigate to the Public Folders

Click the folder with a calendar in it
Right click on the calendar

Select Send Link to the Folder

Put your email address in the To:

Send the email

Open the emall

Right click on the Calendar attachment
Save it to your Desktop

©CooNoO~WNE
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Set the Free/Busy time you publish, change your time interval and font size

Exercise 16: Calendar Options

1. In Calendar View click Tools>>Options

2. Click Calendar Options

3. Click Free/Busy Options

4. Enter the number of months you wish to have published on the
server
Click OK twice to save your change

o

Customize View: Day/Week/Month

Description
Fields... Start, End
[ Filter... | off
’ Other Settings... ] Fonts and other DayMveskMonth View settings
[ Automatic Formatting. .. ] User defined colors for appointments
|
| ’ Reset Current Miew ] [ Ok I ’ Cancel

Exercise 17: Customize your Calendar

1. In Calendar View, right click in the calendar area, NOT on an
appointment
Select Customize Calendar View
Click Other Settings
Set your Time interval, and Font size for your Day and Week views
Click OK.

abrown
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